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Centerpointe Pennsylvania EVR User's Guide 

 
 

CVR's Pennsylvania Electronic Vehicle Registration (PA EVR) provides an electronic link to 
the Pennsylvania Department of Transportation (Penn DOT). The link allows dealers to 
process title and registration transactions, issue license plates, decals, and print registration 
certificates and reports. 
 

About this User Guide 

To locate a topic, browse the Table of Contents menu, or use the Search feature by typing in a 
specific subject. 
For more help on how to find information with this User Guide, continue to Using PA EVR 
Help.  
 

Table of Contents 

Getting Started - Contains system setup information, which must be completed before 
processing transactions with PA EVR. 

EVR Workspaces and Menus - Learn about the functions of PA EVR's menus, buttons, 
toolbars. 

Managing Inventory - Learn how to manage your inventory. 

Inquiries - Learn about available features to query owner and vehicle information. 

Processing Transactions - Learn about the data entry screens used to process Title & 
Registration transactions. 

Reprints, Correction, Backouts, and Recoveries - Learn about PA EVR's additional 
features. 

Tutorial Videos - View tutorial clips which demonstrate PA EVR's features and functions. 
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Using PA EVR Help 

 

This User Guide contains the following features, which can be accessed from on the top 
horizontal toolbar: 

 

Contents: 

When clicked, this button will display the Table of Contents menu in the left-hand margin. (The 
Contents menu is displayed by default when the User Guide is launched). The Table of 
Contents displays the help topics, organized by subject. 

 

Index: 

When clicked, this button displays the help topics, in alphabetical order, in the left-hand margin 

 

Search: 

You can use the Search feature to find help on a specific topic by entering in keywords.  For 
example typing "plate page" into Search text entry box will display a list of topics related to the 
plate page.  

 

Glossary: 

The glossary contains a list of terms frequently used in this User Guide, along with their 
definitions. 

 

Print: 

You can use this button to print out topics contained in this User Guide. 
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Getting Started 

Getting Started 

Once the PA EVR software is installed, the next step is to configure the software and set the 
system options to their proper settings, based on your dealership needs. 
 

Before processing titles and registrations, be sure you have performed the following: 
Completed the Company Setup Screen  
Set the Station Type 
Set up the Printer(s)  
Set up Communications  
Relayed the PA EVR Security Code to CVR 
 

You may also review the system requirements needed to run PA EVR on your computer 
workstation. 
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System Requirements 

 

Centerpointe PA EVR requires at a minimum the following PC hardware configuration:  
  

An Intel PC with a 300MHz processor speed (or better) running Microsoft Windows 2000 or XP 
Professional operating system. 

A VGA Monitor or better (Note: Display resolution should be set at a minimum of 800x600 in 
order to display all system features). 

At least 512 MB of RAM. 

At least 15 MB of available hard-disk space for the program files. 

At least 35 MB of available hard-disk space for database files. 

At least 1 printer (PA EVR has been certified on the Lexmark E232 Laserjet printer). 

An Internet connection using a broadband (high speed) service. 

A mouse and a compatible keyboard. 

A CD ROM drive for installations and updates. 

 

 

Next Topic: Completing the Company Setup Screen 
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Completing the Company Setup Screen 

If PA EVR is being installed for the first time, the Company Setup window will automatically 
display the first time the program is started. 
 

 
Click any data field for an explanation of its function and purpose.  
 
Enter the following information in the window, using the Tab key or the mouse to move 
between fields. When you have finished entering all required data, the OK button will become 
enabled. Click OK to open the PA EVR application. Additional companies can be setup to 
process on this workstation from the Company Maintenance list. 
 

 

Next Topic: Logging on to PA EVR  
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Logging On to PA EVR 

 

Double click the Pennsylvania EVR icon to launch the program. The product splash screen will 
appear, then the User Logon window will display: 

 

 
 

If you have more than one company setup in the application, select the company for which you 
will be processing work, using the Company dropdown list. (For information on adding an 
additional company, see Company Maintenance.) 

The default company will be the company that was last active when the program was closed.  

 

 
 
Provide your User Name and click Logon.  If you have not been assigned a User ID, contact 
CVR Customer Support Central.  The system will validate the entry automatically. 
 
 
 
Next Topic:Setting the Station Type 
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Setting the Station Type 

Click here to watch a tutorial 
video for this topic. 

   
Using the Station menu, you must indicate whether your PA EVR system is a single station, or 
part of a multiple station system. 

If your dealership is setup with a Central Title Clerk and F&I workstations, the F&I workstations 
will work on transactions where the registration will be processed in two separate steps. When a 
Title & Registration transaction is successfully processed, the status will be "PENDING". The 
F&I representative will be able to issue appropriate tag and stickers. 

As part of the Overnight Processing, the PENDING deals will be automatically be pulled over to 
the Central Title Clerk workstation for editing and to be finalized. The finalized step, (using the 
Complete button) will change the status to "COMPLETE". 
 

From the top PA EVR menu bar, click Tools > Options.  
From the Options menu, select the Station tab. 
 
The Station window will display: 

 
Click the Password button to enable the station change options. 
The User ID/Password window will display 
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Enter your User ID and the Daily Password, then click OK. (To obtain the daily password, call 
CVR at 1-800-333-6995, option 2) 

The Station menu will redisplay with Station Type Selection and Filters options enabled. 
Using the Station Type Selection panel, set your station type as one of the following: 
Single Station - Select this option if this computer is the only EVR workstation at your 
dealership. 
F&I Wireless Station – Select this option is this computer will be used by F&I (Finance & 
Insurance) staff. F&I stations can complete the first step (Pend) of the 2-step registration 
process. 
Central Title Clerk Wireless Station – Select this option if this computer is the main 
workstation in a multiple station setup. The Title Clerk Station is responsible for finalizing 
registrations, and managing and assigning inventory. (If your dealership uses a multiple station 
system, only one PC in the network should be configured as the Central Title Clerk Wireless 
Station.) 
Remote Title Clerk Wireless Station - Select this option if this computer is a secondary 
station in a multi-station setup. Remote Title Clerk Stations can finalize transactions, but are 
not responsible for assigning inventory. 
 

When you finished setting your station options, click the OK button to save your changes. 
 

 
 

Continue to Printer Setup  
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Printer Setup 

Click here to watch a 
tutorial video for this 
topic. 

 

Before processing transactions, you must designate which printer(s) will be used to print your 
reports and registration receipts.  

From the top PA EVR toolbar, click Tools > Options.  
From the Options menu, select the Printer tab. The Printer Options screen will display: 
 

 
 

Using the dropdown listings, select the printers to be used as your Reports printer and 
Certificate printer.  

   
Note: The dropdown list will contain all system printers recognized by Windows. Be sure that 
you are selecting a printer that has been certified by CVR. PA EVR currently supports the 
Lexmark E232 and E240 printer. 

   
For additional information, see also: Printer Tab  
 

Continue to Communication Setup  
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Communication Setup 

Click here to watch a 
tutorial video for this 
topic. 

   
Before you can process transactions, you must configure PA EVR's communication settings. 
These settings control how PA EVR will transmit transaction data to to PennDOT and the CVR 
host system  via the internet.  

On the PA EVR vertical navigation bar, click the Communication tab to open the 
Communication menu bar.. 

Click the Setup  button. The Communications Configuration window will display:  

 

 

 

The Active Session dropdown should be set to CVR Host WWW. 

 

The Time Zone should be set to Eastern Standard Time. The time zone setting can be 
adjusted by clicking the dropdown menu, and selecting the proper time zone. 

 

PA EVR requires a high-speed internet connection (such as DSL, Cable, T1, etc.) to transmit 
data. If your dealership has specific requirements and settings for transmitting through the 
internet (such as a proxy server) you must configure them on the Sessions tab.  

For additional information, see also: Communication Configuration  
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Next Topic: Security Code  



Centerpointe PA EVR Online User Guide 

12 

Security Code 

Before your PA EVR workstation is fully functional, your computer’s EVR Security Code must 
be on file with CVR. 
 
To view your system Security Code: 

From the PA EVR toolbar, click Tools > Options to display the Options menu. 

 
The Security Code will appear on the General tab. 

   

 
Contact CVR Support Central at 1-800-333-6995, and relay this security code. 
 

Next Topic: EVR Workspaces and Menus  
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EVR Workspaces and Menus 

EVR Workspace 

This section will allow you to become familiar with the PA EVR workspace and menus. 

 
  

This section explains the following menus: 

Process Menu  

Reports Menu  

Communication Menu  

Maintenance Menu 
  

Options Menu  
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Process Menu 

Process Menu 

 

The Process Menu contains the following buttons: 

Registration - Displays the Registration List, used for 
title and registration processing. 

Inquiry - Displays the Inquiry List, used for performing a 
PennDOT inquiry. 

Inventory - Launches the Central Inventory Management 
(CIM) application, used to view and manage inventory. 
  

For more information, choose a button from the EVR workspace. 

. 
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Registration List 

The Registration List displays all current transaction records. 

 
Click on any of the toolbar buttons for an explanation of its function and purpose. 
 

You can sort items on the Registration List by any of the data columns displayed. 

You can open/review a transaction by either double-clicking on a record, or by highlighting a 

record with your mouse, then clicking the Open button. (To highlight multiple records for 
review, click on the desired records while holding down the Shift or Ctrl keys) 

Registration records in Ipending status can be directly transmitted to the CVR host for 

processing by clicking the Prelim button. Registrations in any other status must first be 
opened for review. 
 

Next Topic: Inquiry List  
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Inquiry List 

The Inquiry List contains records of inquiries which have not yet been transmitted to PennDOT, 
or which have not yet been accepted as valid.  
  

 
Click on any of the toolbar buttons for an explanation of its function and purpose. 
  

To create a new Inquiry, click the New icon in the Toolbar. 

To review an existing Inquiry, highlight the desired record and click the Open button. 
  
For more information, see: Performing an Inquiry  
  
  

Next Topic: Inventory  
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Inventory 

Clicking the Inventory button will launch the Central Inventory Management (CIM) 
application. Using CIM, you will be able to order and receive inventory using Purchase Orders, 
assign and modify inventory, and create inventory reports. 

 

 
For more information on how to use the CIM application, see: Managing Inventory  
  
  

Next Topic: The Reports Menu  



Centerpointe PA EVR Online User Guide 

18 

Reports Menu 

Reports Menu  

 

The Reports Menu contains the following buttons: 

Registration Reports List  
   

Inquiry Reports List  
   

Bundle Report 
 
Reconciliation Report 

 
Debit Summary Report 
 

For more information, choose a button from the EVR workspace. 
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Registration Reports List 

The Registration Reports List displays every current or archived Completed registration in the 
PA EVR system. Registration reports can be reprinted easily by selecting the appropriate icon 
on the Registration Reports toolbar. 

 

Click on any of the toolbar buttons for an explanation of its function and purpose. 
  

For additional information, see also: Reprinting a Registration Form 
  
  

Next Topic: Inquiry Reports List  
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Inquiry Reports List 

The Inquiry Reports List is an archive of completed inquiries previously transmitted to 
PennDOT.  

 
Click on any of the toolbar buttons for an explanation of its function and purpose. 
 
You can reprint or review an inquiry by highlighting the selected record, and choosing either 

Print or Display from the Toolbar. 
Note: Print capability is only available for a paid inquiry (LienVerification). 
For help on processing a new Inquiry, see: Performing an Inquiry  
  
  

Next Topic: Bundle Reports  
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Bundle Reports 

A Bundle Report is generated during PA EVR’s overnight processing, which occurs at the end 
of a reporting day, or prior to new transaction processing the following day. The Bundle Report 
is a listing of all transactions completed on the specified day. It contains customer and fee 
information, and may be used as a source document of transactions posted to the PennDOT 
accounting system. The total dollar amount listed on the Bundle Report is the amount that will 
be credited to PennDOT by way of electronic funds transfer (EFT). 

When you have completed title applications for a particular day, you must print a copy of the 
Bundle Report. Using the Bundle Report as your guide, collect all the deals that were 
completed the previous day and batch the supporting documents. The Bundle Report, 
Applicant Summaries, and all supporting paperwork for the deals listed, must be mailed to the 
CVR Imaging group. 
 

To print a Bundle Report: 

From the Reports Menu, click the Bundle button.  

 

You will be prompted to select a report date from the list provided. 

Note: Report dates are listed in 'MM/DD/YY' format, followed by a single-character suffix, 'C' 
indicating that the 'Complete' Report is ready for printout for the date shown. 

To display a print preview of your report, click the Display button. 
To begin printing immediately, click Print. 

   
If Display is selected, a Print Preview window will display. 
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Complete Report Sample 
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Debit Summary Report Sample 

 

 

To print your form, use the printer icon on the print preview toolbar. 
 
 

Next Topic: Reconciliation Report  
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Reconciliation Reports 

 

The Reconciliation button is used to generate a Bank Reconciliation Report. This report details 
the transactions and their debit date (based on the purchase date), and allows users to 
reconcile their monthly bank statement against completed title & registrations and paid 
inquiries processed.  

 

To print a Bank Reconciliation Report: 

From the Reports Menu, click the Reconciliation button.  

 

Enter the Debit Begin Date, Debit End Date, and specify the number of copies.  

 
 

The Begin and End Dates can be a range in the future or in the past, as long as the 
transactions are available on your system. 

 

You may print the report to the Report printer or display the report on your screen. 

 

A sample of the report is shown below: 

 
Bank Reconciliation Report Sample  
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To print your form, use the printer icon on the print preview toolbar. 
 

 

Next Topic: Debit Summary Report 
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Debit Summary 

 

The Debit Summary Report provides an itemized list of transactions processed, and the 
corresponding fees debited from your account. The report is included and generated with the 
daily Bundle Report. However, using the Debit Summary button, users can generate this 
report on demand, without waiting for PA EVR to complete it's overnight processing and 
bundle report creation. 

 

To print a Debit Summary Report: 

From the Reports Menu, click the Debit Summary  button.  

 

Enter the report Begin Date, End Date, and specify the number of copies.  

 
You may print the report to the Report printer or display the report on your screen. 

 

A sample of the report is shown below: 
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Debit Summary Report Sample  

 
 

Next Topic: The Communication Menu 
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Communication Menu 

Communication Menu 

 

The Communication Menu contains the following 
buttons: 

Communication Setup  

Password Update  
  

For more information, choose a button from the EVR workspace. 
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Communications Configuration 

The Communications Configuration menu controls how PA EVR transmits data to PennDOT 
and the CVR host system. 
 

 
 

The Active Session dropdown should be set to CVR Host WWW. 

The Time Zone should be set to Eastern Standard Time. The time zone can be adjusted by 
clicking the dropdown menu, and selecting the proper time zone. 

PA EVR requires a high-speed internet connection (such as DSL, Cable, T1, etc.) to transmit 
data. If your dealership has specific requirements or restrictions for transmitting through the 
internet (such as a Proxy server) they must be configured on the Sessions tab.  
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To enable proxy server configuration, check the Use Proxy Server box, and enter all 
information required for internet access through your network. 

(Please consult your computer/IT administrator if you are unsure of any these settings) 
   

Next Topic: Password Update  



EVR Workspaces and Menus 

31 

 
Password Update 

The Password Update feature allows users to change or update their password at their 
convenience. 

When the Password Update button  is clicked, a Communications window will display 
prompting you to enter your CVR User ID, Old (current) Password, and New Password of your 
choice. 
  

 
 

New passwords must be between 6-8 characters, and contain a combination of both letters 
and numbers. You may not reuse a password previously used within the last two years. 

   
After clicking the OK button, you will be prompted to confirm your new password by re-entering 
it. 

 
 

Once entered, clicking the OK button will complete your password update. 
 

Next Topic: The Maintenance Menu  
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Maintenance Menu 

Maintenance Menu  

 

The Maintenance Menu contains the following 
buttons: 

Company Maintenance  

Lien Maintenance  

Insurance Maintenance  

Owner Maintenance  

Default Maintenance  
  

For more information, choose a button from the EVR workspace. 
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Company Maintenance 

Using the Company Maintenance List, you can configure PA EVR to process transactions for 
multiple companies. Company information can be added or modified on this screen. 

 

Click on any of the toolbar buttons for an explanation of its function and purpose. 
  

If the company details are not visible from the bottom of your screen, double-click the record or 

click the arrow to display the Company Information window. 
  

To add a new company: 

Click the New button from the toolbar. 
Enter in the company details into the bottom Company Information box 

Click the Save button to save the record to the database. 

PA EVR will maintain a separate database for each company. 

To switch the active company for which you are processing transactions:  

From the toolbar, click File > Logon as New User 

  

To modify an existing company: 

With the proper company selected, type in any corrections into the Company Information box. 

Click the Save button to save the changes to the record. 
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Next Topic: Lien Maintenance  
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Lien Maintenance 

PA EVR contains a customizable database of lienholders and financial institutions. Lienholder 
records can be added, removed, or modified from the Lien Maintenance screen. ELT lienholder 
records from PennDOT are provided for your convenience. 

 

Click on any of the toolbar buttons for an explanation of its function and purpose. 
  

If the lienholder details are not visible from the bottom of your screen, double-click the record 

or click the arrow to display the Lienholder Information window. 
  

To add a new record: 

Click the New button from the toolbar. 
Enter in the lienholder information into the bottom information window. (For non-ELT liens, the 
Lien Code is not needed.) 

Click the Save button to save the record to the database. 
  

To modify an existing record: 

With the Lienholder Information box displayed, type in any corrections the lienholder record. 

Click the Save button to save the changes to the record. 
  
  

Next Topic: Insurance Maintenance  
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Insurance Maintenance 

PA EVR allows you to save frequently used insurance companies to its database. Records 
from PennDOT have been provided for your convenience. 

 
Click on any of the toolbar buttons for an explanation of its function and purpose. 
  

If the insurance details are not visible from the bottom of your screen, double-click the record 

or click the arrow to display the Insurance Information window. 
  

To add a new record: 

Click the New button from the toolbar. 
Enter the company details into the bottom Insurance Information box. 

Click the Save button to save the record to the database. 
  

To modify an existing record: 

With the insurance company selected, type in any corrections into the Insurance Information 

box. Click the Save button to save the changes to the record. 
  

During registration processing, saved companies can be retrieved on the Lien page by clicking 
the Insurance Code dropdown, and selecting the insurance company from the list. 

 

Next Topic: Owner Maintenance  
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Owner Maintenance 

PA EVR allows you to save frequently used owner and lessor information to its database.  

The Owner Maintenance screen will display saved owner entries, which can be inserted into 
registration records.  

 
Click on any of the toolbar buttons for an explanation of its function and purpose. 
  

If the owner details are not visible from the bottom of your screen, double-click the record or 

click the arrow to display the Owner Information window. 
  

To add a new record: 

Click the New button from the toolbar. 
Enter the owner details into the bottom Owner Information box. 

Click the Save button to save the record to the database. 
  

To modify an existing record: 

With the owner record selected, type in any corrections into the Owner Information box. Click 

the Save button to save the changes to the record. 

During registration processing, saved owner records can be retrieved on the Owner page by 
clicking the Last Name/Company dropdown, and selecting the owner from the list. 
  
  

Next Topic: Defaults Maintenance  
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Default Maintenance 

The Defaults Maintenance screen displays any custom templates that you have created. 
Templates save time and data entry by pre-populating the registration pages with the default 
values defined in the template. 

For example, a used car F&I manager can set the default Vehicle Status value to "Used" on all 
transactions created on his/her workstation, thus saving time. 

 

Click on any of the toolbar buttons for an explanation of its function and purpose. 
  

If the template details are not visible from the bottom of your screen, double-click the template 

or click the arrow to display the template information box. 
  

To create a new template: 

Click the New button from the toolbar. 
Create a name for the template, and enter it in the Default Name field. 
Move through the registration data-pages (Vehicle, Owner, Lien etc), and set any values you 
wish to appear by default. 

Click the Save button to save the template in the database. 
  

To modify an existing template: 
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Highlight the template name which you wish to modify. 
Move through the registration data-pages (Vehicle, Owner, Lien etc), and set any values you 
wish to appear by default. 

Click the Save button to save changes to the template. 
  
  

Next Topic: Options Menu  
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Options Menu 

Options Menu  

The Options menu is where you will configure many of your EVR workstation features, 
including DMS import, printer settings, and forms configuration. 
  

 
  

To access the Options menu: 

From the top PA EVR menu bar, click Tools and 
select Options. 
  

  
  

 

The Options menu contains the following tabs: 

General – Enables F&I deal import from your DMS, and the number of days that 
completed registrations will remain archived on your workstation. 

Printer – Designates printers to be used for reports and registration forms. 

Forms – Designates which forms automatically print upon completing a transaction. 

Station – Allows you to modify the workstation type. 

ESD - Controls your preference for electronically receiving software updates. 
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Options – General Tab 

From the General Options tab, you can configure your workstation to import registrations 
(deals) from your DMS. You can also set the number of days that completed registrations will 
remain archived on your workstation. 
  

 

Click on the data fields or toolbar buttons for an explanation of its function and purpose. 

  

To enable DMS Importing: 

Check the F&I Deal Import box. 
Click the Extension dropdown and select your DMS provider (ADP, Reynold&Reynolds, etc.) 
from the dropdown listing. 

The default import directory of C:\CVRImport should not be changed, unless pecified by your 
DMS provider. 
  

For additional information, see also: DMS Import  
  
  

Next Topic: Options - Printer Tab  
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Options – Printer Tab 

Use the Printer tab in the Options menu to designate printers used for reports and registration 
certificates. 
 

 

Click on the data fields or toolbar buttons for an explanation of its function and purpose. 
 

Using the dropdown listings, select the printer to be used as your Reports printer and 
Certificate printer. The dropdown list will contain all system printers recognized by Windows. 

If the registration certificate printouts are misaligned, you may modify the vertical and 
horizontal alignment using the Adjustments tabs. 

When you selected your printers, click OK to save your selections. 
 
 

Next Topic: Options - Forms Tab  
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Options – Forms Tab 

The Forms Tab allows you to adjust which forms automatically print, upon completing a 
registration. 
 

 

Click on the data fields or toolbar buttons for an explanation of its function and purpose. 

Checked items will automatically print when the transaction is successfully transmitted. You 
may also set the default number of copies to be printed. 
 
 

Next Topic: Options - Station Tab  
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Options – Station Tab 

Using the Station menu, you must indicate whether your PA EVR system is a single stand-
alone station, or part of a multiple station setup. 
 

 

Click on the data fields or toolbar buttons for an explanation of its function and purpose. 
 

If your dealership is setup with a Central Title Clerk and F&I workstations, the F&I workstations 
will work on transactions where the registration will be processed in two separate steps. When a 
Title & Registration transaction is successfully processed, the status will be "Pending". The F&I 
representative will be able to issue appropriate tag and stickers. 
As part of the Overnight Processing, the Pending deals will be automatically be pulled over to 
the Central Title Clerk workstation for editing and to be finalized. The finalized step, (using the 
Complete button) will change the status to "Complete". 
 

Click the Password button to enable the station change options. 
 
The User ID/Password window will display 

 
 

Enter your User ID and the Daily Password, then click OK. (To obtain the daily password, call 
CVR at 1-800-333-6995, option 2) 
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The Station menu will redisplay with Station Type Selection and Filters options enabled. 
Using the Station Type Selection panel, set your station type as one of the following: 
Single Station - Select this option if this computer is the only EVR workstation at your 
dealership. 
F&I Wireless Station – Select this option is this computer will be used by F&I (Finance & 
Insurance) staff. F&I stations can complete the first step (Pend) of the 2-step registration 
process. 
Central Title Clerk Wireless Station – Select this option if this computer is the main 
workstation in a multiple station setup. The Title Clerk Station is responsible for finalizing 
registrations, and managing and assigning inventory. (If your dealership uses a multiple station 
system, only one PC in the network should be configured as the Central Title Clerk Wireless 
Station.) 
Remote Title Clerk Wireless Station - Select this option if this computer is a secondary 
station in a multi-station setup. Remote Title Clerk Stations can finalize transactions, but are 
not responsible for assigning inventory. 
 

When you finished setting your station options, click the OK button to save your changes. 
 
 

Next Topic: Options - ESD Tab  
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Options – ESD Tab 

The ESD tab controls your workstation’s preferences in accessing any Electronic Software 
Distribution that becomes available. When a PA EVR software update is available, your 
workstation can download the update from the CVR host system, using the method selected. 
  

 

Click on the data fields or toolbar buttons for an explanation of its function and purpose. 
  

Click any option to perform the updates as indicated. 
  
  

Next Topic: Inventory  
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Managing Inventory 

Inventory Introduction 

This section explains how to manage your Inventory using CVR's Central Inventory 
Management (CIM) application. Using CIM, users are able to order, receive and monitor the 
month/year stickers, weight stickers and the registration form (SA-2C) 
 

 
 

This section contains the following topics: 

Creating a Purchase Order  

Receiving a Purchase Order  

Modifying Inventory Status 

Inventory Reports  
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Creating a Purchase Order 

Click here to watch a 
tutorial video for this 
topic. 

 

To order inventory, you must create a Purchase Order using CIM. The Purchase Order is 
electronically sent to the PennDOT Inventory Warehouse for processing.  

Note: Plates are not ordered using CIM. They are ordered directly from PennDOT.  Once you 
receive the plates from PennDOT, you will enter plate serial numbers into CIM using the 
Receive Only PO function. 
 

From the PA EVR Process Menu, click the Inventory button to launch CIM. 

At the CIM Purchase Orders menu, click Order. 

 
 

At the Order PO screen, click Add Item to add new inventory. 

 
  

Select the Inventory Type to order from the Add Item to PO dropdown. 
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Type in the Order Quantity then click OK. 

To modify list items added to your order, use the Edit and Delete buttons. 

Once all inventory items have been added, click Create This PO to submit the order to 
PennDOT. 

 
  

The inventory will typically be delivered within 3 to 5 business days of when the order was 
placed. 
 
 

Next Topic: Receiving a Purchase Order  
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Receiving a Purchase Order 

Click here to watch a 
tutorial video for this 
topic. 

 

Once your new inventory has been delivered, you must update the CIM database by receiving 
the Purchase Order. 

From the PA EVR Process Menu, click the Inventory button to launch CIM. 
 

To receive stickers: 

At the CIM Purchase Orders menu, click Receive. 

 
  

On the Purchase Order List, click on the Purchase Order to be received. The Receive PO 
screen will display. 

 
  

Sticker serial numbers will be filled into the Purchase Order by the warehouse, when the order 
is shipped to you. 

 
  

Be sure to check the physical inventory against the serial numbers listed on the Purchase 
Order, to verify that the correct inventory was delivered. 
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Once the inventory has been verified, click Update PO to receive the items. 

 
 

The inventory serial numbers will now be listed in the Inventory menu, and are ready to be 
issued. 
 

To receive plates: 

Although the plates are ordered and physically received outside of CIM, they must be entered 
into the CIM system so that they can be issued through PA EVR.  

At the CIM Purchase Orders menu, click Receive Only PO.  

 
  

The Receive Add Item window displays. 

 
Select the inventory to be added from the Inventory Type dropdown. 

Using the packing list, enter the Beginning Serial No, Ending Serial No and Inventory Qty, then 
click OK. 

 
Be sure to check the physical inventory against the serial numbers listed on the Purchase 
Order, to verify that the correct inventory was delivered. 

Add more inventory batches by using the Receive Item button, and repeating the process. 

When all of your items have been entered, click the Submit button. 

 
  

The inventory serial numbers will now be listed in the Inventory menu, and are ready to be 
issued or assigned. 
 
 

Next Topic: Modifying Inventory Status  
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Modifying Inventory Status 

Click here to watch a 
tutorial video for this 
topic. 

 

During your transaction processing, you may be required to modify your inventory. For 
example, you may need to mark missing or damaged inventory. 

From the PA EVR Process Menu, click the Inventory button to launch CIM. 

Click the Inventory tab on the CIM toolbar to display the Inventory List. 

 
  

To view the individual statuses for a specific inventory type, click the plus [+] sign. The 
inventory list will be expanded and sorted by status. 

 
 

To modify the status of an inventory item: 

On the right hand column, highlight the serial number(s) of the items to be modified. 

 
With the items highlighted, click Modify Status. 

The Change Inventory Status window will display. Select the new inventory status from the 
dropdown listing. 

 

Click OK to save the changes and update the inventory status. 
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Note: Inventory cannot be set back to "Available" once its status has been modified. Be sure to 
verify the physical inventory before modifying the status of Inventory item. Inventory cannot be 
modified once it is in "Issued Final" status. 
 
 

Next Topic: Inventory Reports  
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Inventory Reports 

CIM has a reporting feature, which can detail the status of some, or all, of your inventory.  

From the PA EVR Process Menu, click the Inventory button to launch CIM. 

Click the Reports tab on the CIM toolbar to display the Reports List. 

From the left-hand menu, select the Report Type you wish to generate. This will launch the 
Dealer Inventory Reporting screen. 

 
  

Using the bottom inventory listing, select the inventory type for which you need the report. 
(If you need an Inventory Report for all inventory types, select the All radio-button to 
automatically select all inventory.) 

 
  

With inventory types selected, click the Print Preview button. The Print Preview window will 
launch, displaying your inventory report. 

To print your report, click the Printer icon on the Print Preview toolbar. 
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Inventory Summary Report Sample 
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Inventory Detail Report Sample 
 
 

Next Topic: Performing an Inquiry  
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Performing an Inquiry 

Performing an Inquiry 

The EVR Inquiry feature allows you to obtain information about vehicles purchased and 
traded-in, owner and registration information for tags being transferred. The inquiry will help 
you determine if the vehicle has lienholder information (called Lien Verification), or if it has 
brands, etc.  
  

 
Click on any of the toolbar buttons for an explanation of its function and purpose. 
 

To perform a new inquiry: 

From the Process navigation bar, click the Inquiry button to display the Inquiry List. 

Click the New button on the Inquiry List toolbar. The Inquiry Control Number window will 
display. 

 
If necessary, type in a new, unique Control Number, then click OK. (Users can configure PA 
EVR to automatically generate the control number from the Company Maintenance screen.) 
 

Continue to: Inquiry Data Entry  
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Inquiry Data Entry 

Click here to watch a 
tutorial video for this 
topic. 

 

Inquiries may be performed on either a PA license Plate, Vehicle Identification Number (VIN), 
or Title #. 
Inquiries can only be performed using one search criteria. 
 

 

Click any data field for an explanation of its function and purpose. 
 

Required fields will appear in yellow, and will turn white when completed. If the data field is an 
optional part of the processing, the entry area will be white. 

You can narrow the search by providing Owner information with a Plate Number or the First 2-
characters of the Owner’s Last Name with a Title Number. 
To obtain a printed copy of the inquiry for Lien Verification, you must check the Print Inquiry 
box. 
Note: There is a PennDOT fee associated with the printed Lien Verification. 

When you are ready to submit the inquiry request, click the Transmit button and the 
communications send the request to PennDOT. 
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Next Topic: Title and Registration Processing  
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Processing Transactions 

Transaction Processing - Overview 

PA EVR allows you to process the following types of title and registration transactions: 
 

New Issue- A new title and registration are issued with a new plate and sticker. A weight decal 
may be issued for a truck greater than 5000 lbs. 

   
Transfer- This transaction transfers the existing registration to another vehicle. No new plate 
or sticker are issued. For trucks, a weight sticker will be issued if there is change of class. 
 
Transfer Exchange Tag - This transaction is used in situations where the owner is 
transferring the registration to a different vehicle type (e.g., transferring from Passenger to 
Truck, where the original vehicle type is not the same as the vehicle receiving the tag). The 
transfer plate will be exchanged with new plate from inventory, that corresponds with the new 
vehicle type. 
 
Transfer with Renewal- This transaction transfers and renews the existing registration. A new 
sticker is issued. For trucks, a weight sticker will also be issued if there is change of class. 
Renewals can be performed on a registration expiring within the next 90days. 
 
Transfer Exchange Tag with Renewal - Like Transfer Exchange Tag, this transaction 
transfers a registration to a different vehicle type (e.g., transferring from Passenger to Truck), 
while also renewing the registration. Exchange plates and stickers will be issued based on the 
new vehicle type. Renewals can be performed on a registration expiring within the next 
90days. 

   
Transfer with Replacement- This transaction transfers an existing registration and issues a 
new replacement plate and sticker (e.g.- plate is lost, damaged, etc.). For trucks, a weight 
sticker will be issued if there is change of class. 
 
Transfer with Renew and Replacement- This transaction transfers and renews the 
registration, while also issuing a replacement plate and sticker from inventory. For trucks, 
weight sticker will also be issued if there is change of class. Renewals can be performed on a 
registration expiring within the next 90days. 
 
Transfer with Sticker Replacement- This transaction transfers the existing registration while 
issuing a replacement sticker from inventory (e.g.- sticker is lost, damaged, etc.). Registration 
expiration date does not change. For trucks, weight sticker will also be issued if there is 
change of class. 

 
  Title Only- This transaction issues a title only for a vehicle. No registration is issued. 
 
  Standard Renewal- Renewals can be performed on a registration expiring within the next 

90days. 
 

Transactions can be started by either Importing registration data (deals) from your DMS, or 
manually created from the New Transaction Window. 
 

   
 
 

Next Topic: Data Entry  
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Data Entry 

 

Required vs. Optional fields: 
  

When data is required as part of the processing, the entry field will be Yellow.   

 
Once you enter data into a required field, the Yellow is replaced with White. 

 
When data is optional as part of the processing, the entry field will be White. 

 
 

Data Auto-Fill: 

A feature of the PA EVR product is to assist with the data entry as much as possible.  As you 
use the PA EVR product, you will notice several areas where data will be automatically filled in 
for you. 
  

For example, the entry of a valid VIN, populates the related vehicle data, as shown below: 

 
 

Date Fields: 

All date fields are equipped with a dropdown calendar feature for ease of use for the user. To 
insert a specific date, simply click on it from the calendar view. 
  

 
 

 

 

Next Topic: DMS Import 



Centerpointe PA EVR Online User Guide 

62 

DMS Registration Import 

Click here to watch a 
tutorial video for this 
topic. 

 

Registration data can be imported from your F&I Dealer Management System (DMS) such as 
ADP, Reynolds &Reynolds, etc. 
 

To import a record from your DMS: 

Click the Get Deals button on the Registration List toolbar. 

The Registration Import window will display transactions available to import.  

 

Highlight the records to be imported, then click Import on Registration Import window.  

By importing the record, registration data exported from your DMS will be automatically 
transferred into CVR's data-entry pages. 

   
(Note: Both PA EVR and your DMS must be properly configured for the Import feature to 
properly function. PA EVR can be configured in the General Options Menu. For assistance 
configuring your DMS for data export, contact your DMS provider.) 
 
 

Next Topic: New Transaction Window  
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New Transaction Window 

Click here to watch a 
tutorial video for this 
topic. 

 

The New Transaction window is the first step in registration entry. From this window, you will 
select the type of transaction to be processed and provide a Control Number.  

 

Click any data field for an explanation of its function and purpose. 
 

To begin a transaction: 
Create a transaction Control Number in the field provided (if not automatically generated). 
Each transaction must have its own Control Number that is unique to the dealership. (Unique 
numbers such as the vehicle stock number or F&I deal number are common Control 
Numbers). 

   
Click the radio button for the Deal Type you wish to initiate. 

Click Done to advance to the Data-Entry pages. 
 

The Preload feature saves time by retrieving Vehicle and/or Owner information from 
PennDOT, and automatically populating it into your registration pages. When transmitted, a 
preload performs an inquiry on the plate and/or VIN specified, and transfers the results to your 
registration. You may choose to display or print the inquiry results prior to registration 
processing. 
 

To preload registration data: 

Enter your search criteria. You may obtain owner information by submitting a license plate, 
and obtain vehicle information using a VIN and/or title number. 

Using the Inquiry Results field, indicate whether you wish to display/print a Title Inquiry 
Report, or to skip this step. 

Click the Preload button. (Your User ID and Password will be required to submit the request to 
PennDOT). 
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Next Topic: Vehicle Page  
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Vehicle Page 

Click here to watch a 
tutorial video for this 
topic. 

 

The Vehicle page captures the information about the vehicle being sold and contains panels for 
the Vehicle, Title, and Insurance information.  

   

 
Click any data field for an explanation of its function and purpose. 
 

Required fields will appear in yellow, and will turn white when completed. Required fields will 
vary based on whether the registration is for a New or Used vehicle.  

Typing in a valid VIN will automatically populate several fields, including the vehicle Make, 
Model Year, and Body. 

When all required fields have been completed, a green check mark will appear on the Vehicle 
page tab.  
 
 

Next Topic: Owner Page  
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Owner Page 

Click here to watch a 
tutorial video for this 
topic. 

 

The Owner Page captures the information about the Owners, Co-Owners, and their associated 
addresses. (If registration is a lease deal, an additional data entry page will appear for Lessee 
information.) 

 
Click any data field for an explanation of its function and purpose. 
 

Required fields will appear in yellow, and will turn white when completed. Different panels and 
fields within the page are active based on the number of owners and whether the owner type is 
an individual, a company, or a lessor.  

When all required fields have been completed, a green check mark will appear on the Owner 
page tab.  
 
 

Next Topic: Lessee Page  
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Lessee Page 

If the Owner Type is set to Lease on the Owner page, the Lessee tab will appear. Similar to 
the Owner page, the Lessee page is used to capture name and address information of the 
lessee(s) in a lease deal. 

 

Click any data field for an explanation of its function and purpose. 
 

Required fields will appear in yellow, and will turn white when completed.  

When all required fields have been completed, a green check mark will appear on the Lessee 
page tab.  
 
 

Next Topic: Sales Page  
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Sales Page 

Click here to watch a 
tutorial video for this 
topic. 

 

The Sales Page is used to record financial elements essential to the sale of the vehicle; such 
as the Purchase Date, Price, and Trade-In information. 

 

Click any data field for an explanation of its function and purpose. 
 

Required fields will appear in yellow, and will turn white when completed.  

The Purchase Date field displays the current date by default, but you can change the date up 
to 10-days prior. 

When all required fields have been completed, a green check mark will appear  on the Sales 
page tab.  
 
 

Next Topic: Lien Page  
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Lien Page 

Click here to watch a 
tutorial video for this 
topic. 

 

The Lien Page captures the information of any financial lienholders attached to this 
transaction. 

 

Click any data field for an explanation of its function and purpose. 
 

Required fields will appear in yellow, and will turn white when completed.  

When all required fields have been completed, a green check mark will appear on the Lien 
page tab.  
 
 

Next Topic: Plate Page  
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Plate Page 

Click here to watch a 
tutorial video for this 
topic. 

 

The Plate Page reflects the Type or Registration, and is used to record information such as 
plate type and expiration date. 
 

 

Click any data field for an explanation of its function and purpose. 
 

Required fields will appear in yellow, and will turn white when completed. (Required fields will 
vary depending on the Transaction Type).  

When all required fields have been completed, a green check mark will appear next to the 
icon.  
 
 

Next Topic: Renewal Page  
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Renewal Page 

Click here to watch a 
tutorial video for this 
topic. 

 

PA EVR allows users to process a stand alone renewal on an existing registration. Renewals 
can be performed on a registration expiring within the next 90days. Standard Renewals are 
processed on a single data-entry page. 

Note: Renewals are performed as a single-step transaction, and cannot be corrected or 
backed out once complete. 
 

 

Click any data field for an explanation of its function and purpose. 
 

Required fields will appear in yellow, and will turn white when completed. At minimum, you must 
provide the Last 4-digits of the VIN, the Plate Number and Insurance information. 
When all required fields have been completed, a green check mark will appear next to the 

icon. Click the Prelim button to submit the transaction to PennDOT. 
 

When the Commit Abandon screen displays, validate the plate and sticker number. If you 
accept the inventory and the associated fees, click Accept. 
 

   
 
Next Topic: Transmitting Transactions 
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Transmitting Transactions 

 

Once you have entered all the data required for the Title & Registration, all of the tabs will have 
a green check mark. 
 

 
  

To initially transmit the transaction, click the Prelim  button. 
  

You will see a Communications window showing the transmission. 
Note: You may be required to re-enter your User ID and Password when transmitting. 
 

 
 

Before a transaction is completed, the Commit/Abandon screen will summarize the registration 
information. It displays any inventory that will be assigned to the transaction, as well as 
applicable fees due from the customer. 
  

 
 

To continue with the transaction, select the inventory issued to the customer (if applicable) using 
the dropdown list.  When you are ready to complete your transaction, click the Accept button. 
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This will accept what is shown and continue to process the transaction. Once successful, the 
Pull Ticket (or Applicant Summary/Registration Card if finalizing a transaction) will print.  

Clicking the Cancel button rejects what is shown and will discontinue the process. All of your 
registration data remains saved for additional changes or submission at a later time. 
 

   
 

Next Topic: Pending and Complete 
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Pending and Complete 

 

If your dealership is setup with a Central Title Clerk and F&I workstations, Title & Registration 
transactions will be processed in two separate steps. The first step to place the registration in 
Pending status. The second step will finalize the registration and place it in Complete status. 

 

Pending Transactions 

To initially transmit a Title & Registration, use the Prelim  button. 

Upon successful transmission, the transaction will be placed in Pending status.  The F&I 
representative will be able to issue appropriate tag and stickers. 

 

Complete Transactions 

As part of PA EVR's automated Overnight Processing, the Pending deals will automatically be 
retrieved by the Central Title Clerk workstation for editing and to be finalized. To finalize a 
transaction on the PennDOT system, the transaction must be transmitted a second time. To 
submit a finalized transaction, click on the   button. Upon successful transmission, the status 
will change to Complete. 

Central Title Clerk and Single Workstations can choose to COMPLETE the transaction in a 
single process. Central Title Clerk would always COMPLETE transactions retrieved from F&I 
workstations.   

   
 

Note: Title Only and Standard Renewal transactions are completed in a single (one-step) 

process. To submit these transactions, only the Prelim  button is needed.  The Prelim will 
display the assigning inventory and the fees associated with the Title Only or the Standard 
Renewal. 
 

 

Next Topic: Fee Debits and Credits 
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Fee Debits and Credits 

 

Dealer Processing: 
  

For all New or Used Vehicle Sales (Dealers) 

A dealer has 10-calendar days to enter the transaction from the Purchase Date.  If you 
wait until the 10th day, the Title will be automatically produced the next day.    

The dealer’s account will be debited for the fees, 10 days after the Purchase Date. 

Deposit date to Pennsylvania DOT is 20 days from the Purchase Date. 

Title Release Date is a maximum of 5 days from the Process Date (i.e., the date the 
transaction is finalized and Completed).   
  

Vehicle Renewal Transactions - (Dealers) 

Deposit date to Pennsylvania DOT is 2 days from the Process Date. 

Since a title is not produced, the title release date will be the Process Date.   

 

Messenger Processing: 
  

For All Used Vehicle Sales 

Deposit date to Pennsylvania DOT is 10 days from the Process Date. 

Title release date is 2 days from the Process Date.  

 

Deposit Date: 
  

If the deposit date falls on a Saturday or Sunday, the previous business deposit date 
will be used.  This is normally Friday unless it was declared a state holiday.  In that 
case, the deposit day would be Thursday. 

If the deposit date falls on a day that is declared a state holiday, the previous business 
deposit date will be used.  For example, if the holiday falls on a Monday, then the 
deposit day will be the Friday before the holiday. 

 
 

 

Next Topic: Reprint, Correction, Backout, and Recover  
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Reprint, Correction, Backout, and Recover 

Reprint, Correction, Backout, and Recover Features 

This section covers features available to registrations that are in Pending or Complete status. 
  

This section contains the following topics: 

Reprinting a Registration Form  

Correction Mode  

Backing Out a Transaction  

Recovering a Transaction  
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Reprinting a Registration Form 

Click here to watch a 
tutorial video for this 
topic. 

 

PA EVR allows you to reprint registration forms, including pull tickets and registration cards. 
   

To obtain a reprint: 

Click the Reports tab. 

Click Registration to open the Registration Reports List. 

 

Highlight the registration for which you need to reprint. 

From the top toolbar, click the icon of the form to be reprinted. 

With the form selected, click Print to print the form immediately, or click Display to 
preview your reprint. 

If Display is selected, Print Preview window will display.  

 

To print your form, use the printer icon on the print preview toolbar. 
 
 

Next Topic: Correction Mode  
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Correction Mode 

Click here to watch a 
tutorial video for this 
topic. 

 

PA EVR allows you to modify, or "correct" select portions of a Pending transaction. You may 
re-transmit a transaction in Correction mode if you find a data error in your transaction. 

Note: Some registration errors will require a backout to be fixed. See: Backing Out a 
Registration  
 

To correct a registration in Pending status: 

From the Registration List, highlight and Open the registration to be corrected. 

Type any corrections over the existing data. 

When you are ready to send your corrections to PennDOT, click the Correction button. 

Your CVR User ID and Password are required. 

 
 

When the correction has been successfully transmitted, you will be prompted to reprint the 
Applicant Summary with Standard Registration Form. 
 
Note: Transactions cannot be corrected once they are in Complete status. 
 

Next Topic: Backing Out a Transaction  
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Backing Out a Transaction 

Click here to watch a 
tutorial video for this 
topic. 

 

If an error in a Pending registration cannot be corrected using Correction mode, it must be 
backed out. 
Note: Transactions must be in Pending or Ready status in order to be backed out. 
Transactions cannot be backed out once they are in Complete status 
 

To backout a transaction: 

From the Registration List, highlight and Open the registration to be backed out. 

From the Registration Data Entry view, click the Delete button on the toolbar. 
 
A Registration Backout window will display in which you must select an Inventory Disposition 
and Reason for backout. Make the appropriate selection, and click OK. 

 

PA EVR will transmit the request to PennDOT. Your User ID and Password will be required. 
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For additional information, see also: Correction Mode  
 
 

Next Topic: Recovering a Transaction  
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Recovering a Transaction 

Click here to watch a 
tutorial video for this 
topic. 

 

On occasion, a registration record may be missing from the Registration List, or be missing 
information, if your workstation’s data has been corrupted. This can be fixed by connecting to 
the CVR host system and "recovering" the transaction. 

   

 
 

To recover a transaction: 

From the top toolbar, click Tools > Recover. 

The Recover Registration Record window will display. 

Click the New button, and enter the control number of the transaction to be recovered. 

Click the Send button. 

You will be prompted for your CVR User ID and Password. 
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Once the registration has successfully been recovered, click Exit to return to the 
Registration List. 

If the Registration List was open when recovering the transaction, you may need to refresh it in 
order to view the recovered transaction. Simply exit the Registration List and then reopen it. 
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Glossary 

B 
Bundle Report: The Bundle Report is a listing of all transactions completed on a specified day. It consists of a 

Complete Report and a Debit Summary, which detail customer and fee information. The Bundle Report is 
created during PA EVR's overnight processing. 

C 
CIM: Central Inventory Management - CIM is a companion application to PA EVR. Using CIM, users can order, receive, 

and manage inventory. 

CVR: Computerized Vehicle Registration. CVR partners with PennDOT to provide electronic vehicle registration. 

D 
DMS: Dealer Management System (ADP, Reynolds & Reynolds, ARG, etc.) PA EVR can be configured to import 

registration data directly from your company's DMS, if compatible. 

E 
ESD: Electronic Software Distribution- Your MI EVR workstation has the capability to receive software updates 

electronically. 

EVR: Electronic Vehicle Registration- Pennsylvania EVR software is a link through which users can electronically 
process title and registration transactions. 

F 
F&I: Finance and Insurance 

Finalize: When a 2nd step of registration transaction is successfully performed (transmitted), the registration is finalized. 
Finalized registrations display a "Complete" status on the Registration List, and are complete records on the 
PennDOT system. 

O 
Overnight Processing: PA EVR automatically performs this system process at the end of a reporting day, prior to the 

next day's transaction processing. During overnight processing, PA EVR will generate the Bundle Report, and 
perform data backup and purging processes. 

P 
Pend: When the 1st step of a 2-step transaction is completed, the title & registration is placed into a Pending status. 

Pended registrations are not full registration records, and must be retransmitted within 10 days to become 
permanent registration records. 

PennDOT: Pennsylvania Department of Transportation 





 

85 

Index 

B 

Backing Out a Transaction.........................................84 

Bundle Reports..........................................................21 

C 

Communication Menu Introduction.............................28 

Communication Setup................................................10 

Communications Configuration ..................................29 

Company Maintenance..............................................33 

Completing the Company Maintenance Screen ...........5 

Correction Mode ........................................................83 

Creating a Purchase Order ........................................51 

D 

Defaults Maintenance ................................................41 

DMS Import ...............................................................65 

E 

EVR Workspace Introduction.....................................13 

G 

Getting Started Introduction .........................................3 

I 

Inquiry Data Entry ......................................................61 

Inquiry Introduction ....................................................60 

Inquiry List .................................................................16 

Inquiry Reports List....................................................20 

Insurance Maintenance..............................................37 

Inventory....................................................................17 

Inventory Introduction ................................................50 

Inventory Reports ......................................................57 

L 

Lessee Page..............................................................71 

Lien Maintenance ......................................................35 

Lien Page ..................................................................73 

Logging On to PA EVR ................................................6 

M 

Maintenance Menu Introduction.................................32 

Modifying Inventory....................................................55 

N 

New Transaction Window ..........................................66 

O 

Options - ESD........................................................... 49 

Options - Forms ........................................................ 46 

Options - General...................................................... 44 

Options - Printer........................................................ 45 

Options - Station ....................................................... 47 

Options Menu Introduction ........................................ 43 

Owner Maintenance .................................................. 39 

Owner Page.............................................................. 70 

P 

Password Update...................................................... 31 

Plate Page ................................................................ 74 

Printer Setup............................................................... 9 

Process Menu Introduction........................................ 14 

R 

Receiving a Purchase Order ..................................... 53 

Reconciliation Reports .............................................. 24 

Recovering a Transaction ......................................... 86 

Registration List ........................................................ 15 

Registration Process Overview ................................. 63 

Registration Reports List ........................................... 19 

Renewal Page........................................................... 75 

Reports Menu Introduction ........................................ 18 

Reprint Backout and Recover Introduction ................ 81 

Reprinting a Registration Certificate .......................... 82 

S 

Sales Page ............................................................... 72 

Security Code ........................................................... 12 

Setting the Station Type.............................................. 7 

System Requirements................................................. 4 

U 

Using PA EVR Help .................................................... 2 

V 

Vehicle Page............................................................. 68 

W 

Welcome..................................................................... 1 

 


	Centerpointe Pennsylvania EVR User's Guide
	Using PA EVR Help
	Getting Started
	Getting Started
	System Requirements
	Completing the Company Setup Screen
	Logging On to PA EVR
	Setting the Station Type
	Printer Setup
	Communication Setup
	Security Code

	EVR Workspaces and Menus
	EVR Workspace
	Process Menu
	Process Menu
	Registration List
	Inquiry List
	Inventory

	Reports Menu
	Reports Menu
	Registration Reports List
	Inquiry Reports List
	Bundle Reports
	Reconciliation Reports
	Debit Summary

	Communication Menu
	Communication Menu
	Communications Configuration
	Password Update

	Maintenance Menu
	Maintenance Menu
	Company Maintenance
	Lien Maintenance
	Insurance Maintenance
	Owner Maintenance
	Default Maintenance

	Options Menu
	Options Menu
	Options – General Tab
	Options – Printer Tab
	Options – Forms Tab
	Options – Station Tab
	Options – ESD Tab


	Managing Inventory
	Inventory Introduction
	Creating a Purchase Order
	Receiving a Purchase Order
	Modifying Inventory Status
	Inventory Reports

	Performing an Inquiry
	Performing an Inquiry
	Inquiry Data Entry

	Processing Transactions
	Transaction Processing - Overview
	Data Entry
	DMS Registration Import
	New Transaction Window
	Vehicle Page
	Owner Page
	Lessee Page
	Sales Page
	Lien Page
	Plate Page
	Renewal Page
	Transmitting Transactions
	Pending and Complete
	Fee Debits and Credits

	Reprint, Correction, Backout, and Recover
	Reprint, Correction, Backout, and Recover Features
	Reprinting a Registration Form
	Correction Mode
	Backing Out a Transaction
	Recovering a Transaction

	Glossary
	Index

